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Disclaimer 
Giffels Associates Limited makes no representation or warranties of any kind with respect to 

the contents of this document and specifically disclaims any implied warranties of 

merchantability and fitness for any particular purpose.  Giffels reserves the right to revise 

this publication without notice.  Under no circumstances shall Giffels Associates Limited be 

responsible for consequential, incidental, special or indirect damages arising out of the use 

of, or inability to use this document or any products referenced herein.  The user is hereby 

solely responsible for assessing their needs. 

 

The screen displays depicted herein are meant to be representative and not exact duplicates 

of those that will appear on your monitor. 

 

Trademarks 
PROJECT NAVIGATOR is a trademark of GIFFELS ASSOCIATES LIMITED.  

Intergraph, IGDS, CLIX, and CLIPPER are registered trademarks of Intergraph Corporation.  

MicroStation is a trademark of Bentley Systems, Inc., an Intergraph affiliate.  Other brands 

and product names are trademarks or registered trademarks of their respective owners. 

 

Copyright Notice 
© Copyright 2000, GIFFELS ASSOCIATES LIMITED. All rights reserved. 
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Preface 
This document is intended to serve as a supplement to the classroom training session 

presented by Giffels Associates Limited. Much of the instructional value of this document 

will be lost without the coaching and instruction of a qualified Giffels instructor. 

 

Contained in this guide are course objectives, student learning aids, student self evaluation, 

course evaluation and exercises completed during the training program. There are also 

references to particular sections of the TIMS documentation supplied with the TIMS 

software. Students are encouraged to refer to these other sections for more information about 

particular topics. 
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TIMS Systems Administrator Training Course Objectives 
Perform NT Systems Administer duties as related to TIMS 

− Control and troubleshoot reference file logical name issues 

− Locate the main TIMS program files for installation and modification 

− Understand the TIMS database structure and unique keys 

− Manage lookup lists (e.g. titles, file extensions, project status) 

− Create custom document fields 

− Create add-in custom tools 

− Setup NT user login and file security as it relates to TIMS file check in/out 

− Use ODBC 32 to create and manage a data source 

− Compact and repair the TIMS database 

 

TIMS Manager Training Course Objectives 
Upon successful completion of this training course user will be able to: 

Perform the TIMS Managers Duties to: 

− Manage project information in the Projects Table 

− Setup Data Access Rights (permissions) 

− Modify maintenance table data 

− Check the file transfer audit log 

− Identify and use the file transfer checkout log 
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TIMS NT System Administrator Duties 
Things you should know before starting this section: 

• Node Name (TCP/IP hostname) of the File Server 

• Node Name (TCP/IP hostname) of the Database Server 

 

In this section you will be able to: 

• Add new users and groups to an NT domain 

• Locate the TIMS File server(s) and the Database server 

• Install TIMS System files 

• Perform trouble shooting on: 

��Reference file logicals 

��TIMS Program files 

• Compact and repair the TIMS database 
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NT User and Groups 

• The TIMS users are defined by the NT operating system 

• Each user must first be given an NT login 

• Each user must be associated with one or more NT groups and their primary NT group 

chosen carefully 

• Users and groups are set up by the NT Administrator 

• Once the NT users and groups are set up they can be added to the TIMS User Privilege 

table (can actually be added before they are created if username is known) 

Adding a user to an NT Domain 

Login in as the Administrator 

Locate and startup the Administrator Tools  

Open User Manager for Domains  (servers only) 

Select User>New User 

Add the new username and other pertinent information 

Click on groups and select the group or groups to associate with the username 

Click on profile to assign a users home directory 

Adding a group to an NT Domain 

Login in as the Administrator 

Locate and startup the Administrator Tools  

Open User Manager for Domains (servers only) 

Select Group>New group Groups 

Add in a new group name 
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Managing the Database 

• With the MS Access version of TIMS the database is a single MDB file 

• The file called TIMSDATA.MDB must be accessible by all client workstations through a 

shared drive connection. 

• When the Database server is installed to the default directory it will be located in the 

C:\WIN32APP\TIMSV3\TIMSDATA directory.   

• It is required that the C:\WIN32APP\TIMSV3\TIMSDATA directory or a similar location 

be set up as a share for everyone to have full access.  

• This share point should then be mapped as a drive letter on each client workstation that 

needs to access TIMS (drive letter T: for TIMS is suggested) 

Project Navigator Database Setup 

• Project Navigator requires a 32bit ODBC System DSN to be defined (done during 

installation). Using the Control Panel, open 32bit ODBC and click on the System DSN 

button (TIMS or TIMSAccess should not exist in the User or File DSN tabs) 

• Select TIMSAccess (Microsoft Access Driver (*.mdb)) and click on Configure. Do not 

change the name from TIMSAccess; the software is hard coded to locate this DSN name.  

Click on Select and select the database file to be used (e.g. T:\timsdata.mdb). Click OK 

and Close all dialog boxes 

- OR - 

• Select TIMS (SQL Server) and click on Configure. Do not change the name from TIMS; 

the software is hard coded to locate this DSN name.  Ensure the SQL Server name is 

correct.  If the login ID will be verified with SQL Server authentication, then ensure that it 

connects with the Login ID of ‘timsuser’ with no password.  Ensure that the correct 

network library is used (TCP/IP or NamedPipes).  The default database should specify 

‘tims’ and you might wish to turn OFF the option to ‘Create temporary stored procedures 

for prepared SQL statements’ and to turn ON the option to ‘Perform translation for 

character data’.  Test the Data Source to ensure it is successful and then close all dialogs. 
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TIMS Data Manager Database Setup 

• During the first usage of the TIMS Data Manager after installation the Data Manager 

application prompts for the location of the database containing all the TIMS project, 

document, company and contact data [TIMSDATA.MDB] 

• This information is stored into the TIMS Data Manager application (TIMS.MDE) so it 

does not prompt on the second and subsequent use. 

• If there is a need to relocate the database for the TIMS Data Manager: you must 

remove/rename the old TIMSDATA.MDB then during the next restart of TIMS Data 

Manager you will again be prompted to identify the new location of the database. Or, 

alternatively, you may press CTRL-A at the main TIMS Data Manager Menu to open a 

dialog to allow you to reselect the database and force it to renew its (cached) pointers to 

the database. 
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Exercise: 
���� Locating the TIMS Database: 

1. Open the 32-bit ODBC option from Windows Control Panel. 

2. Locate the System DSN. 

3. Select TIMS (MS SQL Server) or TIMSAccess (MS Access). 

4. Check that this is using the correct TIMSDATA.MDB (MS Access) or SQL Server 

with correct DB Library type (TCP/IP, NamedPipes, etc). 

���� Installing TIMS: 

1. Insert the CD-ROM in the drive and the TIMS Installation process will start 

automatically. To manually start the TIMS installation runs the setup.exe in the 

root directory on the CD-ROM. 

2. From the dialog that appears select the TIMS Client icon. 

3. Select the TYPICAL option for Project Navigator and TIMS Data Manager 

installation. 

4. Select MINIMUM for Project Navigator only. 

5. You will be prompted for the following: 

- directory for MicroStation 

- Node name (this is the Database server name) 

- Services id: (usually 1493-check first with NT services to ensure this number 

has not already been used) 

- Local client working directory/branch for all project files to be transferred to 

���� Changing the location of TIMSDATA.MDB (MS Access only): 

1. Move the TIMSDATA.MDB file to a new location (move the old one out of the 

way by un-mounting the drive location or renaming it) 

2. Open the 32 bit ODBC option from Windows Control Panel, access the System 

DSN tab and configure the TIMS/TIMSAccess DSN. For Access select the file 

location using the dialog button provided. 

3. Startup TIMS Data Manager. When prompted locate TIMSDATA.MDB. 
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���� Create new NT logons and run TIMS as these new users: 

1. Create a number of logons with different NT domain groups as the primary group 

using the User Manager for Domains utility. 

2. Logon with each of these accounts and run the Project Navigator and then examine 

the username entries that are created automatically by the system, noticing how the 

primary group is placed first in the list of groupnames for this user logon and how 

each is defaulted to be a User / Operator. 

3. Before logging on and running TIMS with a new account name, experiment by 

adding these usernames to the TIMS User Privilege table, adding the logon name, 

setting the level to Reviewer or None or TIMS Manager, and leave the groupnames 

field blank, or pre-fill it with some groupnames.  Now when you run TIMS for the 

first time as these accounts, notice how the blank groupname fields are filled with 

the NT domain groups for the logon and how the non-blank groupname fields are 

NOT filled with NT domain groups for the logon.  In both cases, the level remains 

as whatever has been pre-set earlier.  This is how you can predefine the user 

operator levels before the TIMS software creates user accounts automatically 

during first-time usage. 

 

���� Add users to additional NT domain groups to allow them to access 
documents from other departments (groups): 

4. The first method is the most correct way of granting a user to gain access to files 

whose document record belongs to another group, other than one of the groups that 

he may currently belong to as listed in the TIMS logon account.  Using the User 

Manager for Domains, add a new NT domain group to the user account (use a 

group that is already created in the TIMS database, otherwise add it in before 

continuing).  Then run the TIMS Data Manager, locate the user logon name and 

blank out the list of groupnames that is listed for this user.  Logon as the user with 

the updated groupname information and run the Project Navigator.  Check that the 

TIMS software has updated the users groupname information in the User Privilege 

table.  You have the option of manually adding this new groupname to the user’s 
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list of groups, but you MUST be very careful that you use the correct syntax with 

single-quotes and comma delimiters…if unsure, let the system do it for you. 

5. The next method is only possible if the underlying NTFS permissions for the files 

grant Everyone to have full access to the file, such as in a TIMS system that locks 

the users into Database View mode only, with no option to access files using the 

File List View.  That being the case, you could simply edit the TIMS logon 

account name and manually add the groupname to the user’s current list of groups, 

paying careful attention to the syntax of single-quotes and comma delimiters.  By 

being locked in the Database View, the document record will solely determine the 

users access rights to edit this file, coupled with the fact that the underlying NTFS 

permissions grant the user with permission to change the file. 
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Reference File Logicals 

• When using TIMS do NOT use MicroStation’s ability to store the full file path names for 

reference files. 

• Using the TIMS preferences inside MicroStation set both: 

1. Resolve Reference Paths ON (click OFF if you want to skip this feature and save time 

during MicroStation loading of the design file, useful if you have many, many 

reference files and you do not want to spend time to see all references from other 

project directories, as this does take some time to process on slower PCs). 

2. Force Ref Logical Attachment ON if you often copy files from one project when 

starting up another project and the reference files will NOT be part of the new project.  

This ensures the files in the new project will continue to locate the reference files from 

the original source project directory (click OFF if you do not want this feature) 

 
• When attaching reference files from another project use the Applications pull-down 

• Select TIMS Toolset->Attach Ref, and the Project Navigator will appear (remember to 

keep it minimized when not being used, to maintain the OLE connection between it and 

MicroStation). 

• Double-click to select the file to attach using Project Navigator (no need to Copy Out the 

file first, Project Navigator does this automatically if necessary) 

• Complete the normal MicroStation reference file attachment details. 
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TIMS Database Structure 

• The TIMS data is a relational database and has many tables that rely on other tables 

• The following is by no means complete in the structure, however it is explained so one can 

see the relationship between the TIMS Data Manager Forms. 
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Repairing TIMSDATA (MS Access option only) 

• The data is stored in the TIMSDATA.MDB file. 

• On occasion the information in this file can become corrupted and may need to be repaired 

and compacted (for MS Access 2000, compacting will also repair at the same time). 

• Open Microsoft Access TM 

1 Close the database. If you are in a multi-user environment, confirm that all 

users have closed the database. 

2 Backup the TIMSDATA.MDB file for safety, e.g. copy to TIMSDATA.BAK. 

3 Start MS Access with no database open.  On the Tools menu, point to Database 

Utilities, and then click Repair Database.  Locate the TIMSDATA.MDB file 

and click on Repair. It should notify you that the repair was successful. 

4 Now select Tools->Database Utilities->Compact Database. 

5 In the Database To Compact From dialog box, locate TIMSDATA.MDB. 

6 In the Compact Database Into dialog box, specify a name, drive, and folder for 

the compacted database. You may specify TIMSDATA.MDB if you have 

already made a backup copy of the file. 



TIMS3 MANAGER GUIDE  PAGE 18 

   

Duties of a TIMS Manager  
Things you should know before starting this section: 

• Node Name (TCP/IP hostname) of the File Server 

• Node Name (TCP/IP hostname) of the Database Server 

• Find, Edit, Add and Delete records in TIMS Data Manager 

 

In this section you will be able to: 

• Manage projects 

- Add project records and directories 

- Change project status 

- Move Project directories and associated files 

• Set TIMS Security 

- Modify database access rights 

- Set User Privilege Levels 

• Manage the Maintenance Tables (18) 

- manage lookup lists 

- create custom document fields 

- set the document type extensions 

• Check the file transfer logs 

- Archive file transfer history log 

• Troubleshoot file transfer problems 

- Modify the file transfer log and fix file attributes  
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Manage projects 

• The Project record controls the location of project directories and files.  You may access 

the record attributes using either the TIMS Data Manager or the Project Navigator. 

• Directory pointers must be to a TIMS FILE SERVER (this must be known) 

• One can create sub-projects, which are a pointer to a sub-directory of a Project directory 

and is most easily visualized when using the Project Navigator. 

• Project directories and files can be move by editing the path of a project.  The TIMS Data 

Manager will attempt to move the underlying directory if it is changed.  The Project 

Navigator does NOT CURRENTLY move the directory, but it will modify the directory 

path value in the project record…use caution with the Project Navigator. 

• Only ACTIVE project files will be seen by TIMS users, or if the TIMS Manager turns on 

the User Setting in the Project Navigator to view All Projects. 

• Files in Projects with status other than ACTIVE will not be available for review or modify 
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Preferably, you will use the TIMS Data Manager to manage your project records, as it has all 

the triggers required to ensure that your modifications to the record attributes, such as the 

project path and underlying directory on the file server, are valid. 
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For quick System Manager access, the Project Navigator has also been ‘equipped’ to allow 

you to perform Project Record management.  This is not the preferred tool to use, as it does 

not validate all inputs (e.g., the path will not be moved if it is changed). 
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Exercise: 
���� Creating a Project using the TIMS Data Manager: 

1. Click CANCEL for a blank record 

2. Click on INSERT 

3. In the Name (ID) field key in the new project name C97001 

4. Leave the Sub-Project field blank 

5. Fill in the Description field: This is my name project creation 

6. Be the manager and select a company to do the work for 

7. In the Node field key in the name of your FILE SERVER 

8. Notice the path for the project files has been pre-assigned. 

9. The Status is set to ACTIVE by default. 

10. Key in a Charge No. for future accounting N097101 

11. Fill in the Ref Number for Client referencing: 97-7896 

12. SAVE the project record. 

13. Create a second project using Duplicate Record. 

14. Name this project C97002 

15. SAVE 

���� Moving a Project: 
1. Find the record for C97001 and select EDIT 

2. Modify the path to: C:\TIMS_Projects\c97001\ 

3. SAVE 

���� Change Project Status 
1. In the Projects form execute a query for C97002 

2. Select EDIT 

3. Modify the STATUS to ON-HOLD and SAVE 
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���� Creating a Project using the Project Navigator: 
1. Log in as the Administrator 

2. Start the Project Navigator and click on the All Project Books icon in the left-side 

project tree view pane. 

3. To create a top level project, ensure the All Projects Books icon (or Last Access 

Projects Books icon) is selected and then you can either right-click or select 

Project->New to create a new project.  To create a subproject, simply highlight the 

appropriate parent project first before selecting Project->New. 
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TIMS Security 

• There are two forms for setting security: 

• Access Rights:  

• User Privilege Levels 

• Only those with TIMS Manager privilege have access to modify security levels  

• These two forms can be accessed from the TIMS Data Manager Main Menu Security 

Menu button 

User Privilege Levels 

• The following are the User Privilege Levels: 

1. TIMS Manager - has access to everything 

2. Operator/User - has access only to privileges set in the access rights table 

3. Reviewer 

4. None 

• Users are by default set to the User/Operator Class 

• To give a user TIMS Manager access they must be entered in the User Privilege Form and 

their User Class set to TIMS Manager 

• Users can also be set to be Reviewers, ideal for those using documents but not editing 

them, such as project managers.   

• To deny specific users from using TIMS, their primary group may be excluded from the 

TIMS3 group’s table, or individual users may be set to a user class of None. 

• The User Privilege form can either be used in a Datasheet mode or in Form mode. Toggle 

between the two modes using the Datasheet and Form View icons at the upper left are of 

the menu bar. 
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Exercise: 
���� Changing user Access 

1. Log in as Administrator 

2. Open Security Menu…User Privilege Levels 

3. Locate your username. If it is not in the database add it as a new record 

4. Set the Class to TIMS Manager 

5. Select another username and set the Class to Review 

6. Exit this form using the window controls in the top right corner of the Forms 

window 

7. Logout  

8. Log in as the REVIEW User and try to Check Out a file  

9. Logout and log back in as yourself 

10. Create a new project under your username 
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User Access Rights 

• The TIMS Manager will always have all access rights to all documents 

• Sets USER RIGHTS to 7 forms in the Data Manager: 

• Document Set Entries 

• Document Sets 

• Document 

• Contact 

• Company 

• Project  

• Tools 

• There are 4 Access rights to be set for each form  

• Review: review records 

• Edit edit records 

• Insert create new records 

• Delete remove records 

• The access right levels are: 

• All:  allows all users access 

• Group:  only users that belong to the same group have access 

• Owner:  only the owner has access 

• None:  no users have access, only those with TIMS Manager privileges have 

access 

• This form is always in edit mode 
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Exercise: 
���� Changing Access Rights 

1. Open Security Menu…User Privilege Levels 

2. Change the Document Set Entries access Edit access to Group 

3. Change the access to delete Projects to None 

4. Change the access to Insert and Edit Projects to None 

5. Change Document Edit, Insert and Delete access to Group 

6. Set the Document Sets Edit, Insert and Delete access to Owner 
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Manage the Maintenance Tables and System Configuration 

• There are 25 tables to be maintained in the TIMS Data Manager, 13 from the Table 

Maintenance option and 12 more from the System Configuration option 

• Only those with TIMS Manager privileges have access to these tables 

• Most items in the tables appear as drop down choices in other forms 

• The Custom documents table items appear as field labels on the Document Detailed 

Definition Form on the Customs Tab 
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Exercise: 
���� Adding plot sizes to the lookup table: 

1. Open the Maintenance table 

2. Select Plot Sizes 

3. In the next available blank field key in the Plot Size E 

4. In the size field key in 36” x 24” 

5. Close the form 

6. Open the Document Details Form and Select the Details Tab 

7. Select the drop down arrow for Plot Size 

8. Plot Size E should now be added to the list 

���� Adding document sub types and file extensions: 
1. Open the Maintenance table 

2. Select graphic sub type 

3. In the first field in the next blank record key in MsPP 

4. In the next blank field key in PowerPoint Presentations 

5. Close the graphic sub type form 

6. Open the File extensions table 

7. In the first field in the next blank record, select the down arrow and select the file 

type MsPP 

8. Set the file extension to PPT. 

���� Linking NT groups to a discipline in TIMS: 
1. Open the Maintenance table 

2. Select Disciplines 

3. Add a RoadDesign discipline 

4. Exit the table 

5. Select Groups 

6. Key in a valid NT Group. (See Systems Administration for adding NT Groups) 

7. Label the group. 
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���� Creating Custom Fields: 
1. Open the Maintenance table 

2. Select Custom Fields 

3. Select the GRAPHICDOCS subtype at the top pull down list 

4. In the first text field key in Major_Road 

5. In the second field key in Starting_Intersection 

6. In the third field key in Ending_Intersection 

7. In the first numeric field key in Northing_Start 

8. In the second numeric field key in Easting_Start 

9. In the first numeric field key in Northing_End 

10. In the second numeric field key in Easting_End 

11. Close the custom fields 

12. Open the Detailed Documents form and select the Custom Tab to review the 

custom fields. 

13. Start the Project Navigator and select a Graphic document, select the properties 

option and you can review the custom fields tab.   
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Managing the File Transfer Logs 

• The file transfer log should be checked regularly for any files that have not been properly 

transferred 

• To correct a problem that has occurred during file transfer there are three items that need 

to be addressed: 

1. The location of the most up to date file  

2. The files attributes need to match those in the file transfer log: 

3. The status of the file in the file transfer log 

Status: Client Attributes: Server Attributes 

MOD (check out) read/write (RW) read 

REV (copy out) read (R-) depends on ownership 

Trouble Shooting 

• The key here is to match the attributes with the file transfer status. 

1. Locate the latest version of the file 

If it is on the server then delete the client file  

There may be a copy of the file on the server named: filename~.ext, this may be the 

latest copy, if so rename it, otherwise delete it. 

2. Reset the file attributes 

If the latest file is on the client, then change the file attributes to match the check out 

mode in the FILE TRANSFER LOG and transfer the file 

If a file is copied out and cannot be remove, change the attributes to read only and try 

transferring it once again 

3. If the file is missing on the local machine, or the client has been destroyed then remove 

the record from the file transfer log and reset the attributes on the server file. 
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• Periodically, depending on the volume of records created, the FILE TRANSFER 

HISTORY LOG needs to be Archived.   This table records all file transactions related to 

the files controlled under TIMS including: creation, check out/in and deletions.  Open the 

form and locate all or a selection of records.  Select Archive and click on the period to 

archive. 
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Exercise: 
���� Checking the file transfer log 

1. In TIMS Data Manager select File Transfer 

2. Open the File Checkout Log 

3. Sort the Data to locate the records that are non-permanent and are older that today 

���� Fixing a document with a missing local file 
1. To create the scenario, Check Out a file 

2. Using the NT Window Explorer remove the file from the local system 

3. Try checking the file in though Project Navigator 

To Fix: Option 1 
1. Change the file privileges on the file server to read/write 

2. Remove the file transfer record from the File Transfer Log Table 

To Fix: Option 2 
1. Copy a dummy file into the local project directory and name it the missing 

filename. Ensure the file has read/write privileges. 

2. In Project Navigator select the file and right click selecting “Cancel Check Out” 
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Review Topics 

• Define the difference between a list of files in directories on the server versus 

the project and document listing that you see in PNAV Database view. 

• Define the physics of what happens when you actually check-out a file: 

verifies in db that file is not already checked out, sends a request to the XFER 

file server to copy the file from server to client PC, file on client is RW, file on 

server is switched to R-Only, entry in XFER Checkout table (tblXfers) is 

created to mark file as being checked out for MOD. 

• Define where files are copied to on local PC (FT_FSYS) 

• Define what double-clicking does. Check-Out the file as above, but use the 

default location reference files, and check them out as well.  This behavior can 

be modified in two ways: 

1. User Settings->Do Not Update References on File Open – by default this 

setting is turned OFF, so reference files WILL automatically get copied out 

when the master file is double-clicked in PNAV.  As the TIMS Manager 

only, you can turn this ON or OFF using the TDM, Security->User Privilege 

Level, locate the user(s), change the Update References on File Open 

toggle option. 

2. User Settings->Checkout References – this is a setting that only the user 

can set and it is saved in the TIMS3 Current User registry section.  It 

controls whether reference files are Checked-out or Copied-out by default 

during double-click.  User may override on the fly if a right-click Check-out -

>With References is done instead of double-clicking. 

 

• Run DBSync to find orphaned records, and / or missing files (report only) 
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• Run DBSync to bulk load data into the TIMS system, for e.g., from a CD.  

Must copy files for one group to the server directory and then DBSync with a 

user/group, and then copy the next set of files for another group to the server 

directory and select the next user/group during bulk loading.  Otherwise, you 

have to use DnD with PNAV and log on as each user/group to set the files’ 

ownerships automatically based on the current logon.  Or, if NTFS does not 

matter, bulk load them all in, using a special description/title, and then globally 

change the docs using TDM or DirectAccess.mdb global linkages. 

• Use TIMS Data Manager to generate reports 

• Use the reporting wizard to generate adhoc reports 

• Use TIMS Data Manager to make global changes to document properties by 

going to Datasheet View.  Show reporting option in Datasheet View. 

• Use TDM to move projects from one directory/drive/server to another. 

• Run cleanup interactively 

• Set up MS Access to query/control the TIMS3 data directly 

• Show how to set up the TIMS3 security model, and what the settings mean 

• Showing how to setup NTFS permissions on the file server for TIMS3 data as 

per our security model, i.e. Set the top level directory to System:F, Admins:F, 

Everyone or Domain Users:R for a typical group access model. 

• How to use the RefUtil program to generate reference file listing reports, 

modify attachment names, building input files for an entire directory tree, etc 

• Use PNAV to MOVE projects from one branch to another 

• Use PNAV to COPY+PASTE a directory branch, with docs, document sets, 

subprojects (e.g. template project trees) 

• Create a project tree and use it as a template to create new projects, with and 

without documents. 

• Show revisions maintenance form in PNAV (TDM is not good at this) 

• Show revisions sequencing IDs, with column to select which is to be used 
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• Show what automatic revision locking is (how it will lock file when received, 

and when it is checked out or ‘unlocked’ it will automatically bump up the rev 

number to the next one on the list. 

• Show how to lock all documents in a folder, to prevent people from checking 

them out.  Currently, you must use TDM (datasheet view) or 

AccessDirect.mdb to locate all the documents using the ProjectID and then 

CTRL-H to do a Global Search and Replace to set the Locked field.  

Alternatively, there is a SQL script that can be used to lock all documents in 

an entire, specified project tree.  Future version will have an option in PNAV to 

do this upon locking of a Project Record. Once a doc record has been locked, 

a non-TIMS Manager user will see the Doc Properties in PNAV as dimmed but 

checked ON.  And if he tries to check it out, PNAV will ask if he would like to 

unlock it to start a new revision, but it will fail to unlock it if the user is a non-

TIMS Manager (note: even though the Doc Revision Create access is set to 

say ALL, a non-TIMS Manager cannot unlock the file to create a new 

revision). 

• Define where MS_SEEDFILES is set and used on file servers 
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• Use TDM to add to the seedfiles option pull down list: 

Select Administration->Table Maintenance->Graphic Sub Types, and then 

add in more entries for dummy ACAD types, such as ACAD1, ACAD2, 

ACAD3, etc. 
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• Next select Administration->System Configuration->Seed Files and add 

entries for seedfiles for these new graphic sub types. You may add up to two 

more seedfiles for each graphic sub type, one for 2D and one for 3D.  In the 

case of AutoCAD, there is no such distinction, but for other CAD s/w such as 

MicroStation, this distinction does exist.  The unique fields in this table are the 

first column, Graphic Type and the fourth column, Dim…so for e.g., you can 

specify a seedfile for Graphic Type ACAD1 and Dim 2D, and then another 

seedfile for Graphic Type ACAD1 and Dim 3D. 
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